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Mitgliedsbeitrag für 1992 
 
 
Die DUG-Mitglieder aus Österreich werden gebeten, den Mitglieds-
beitrag von S 300.- für das Jahr 1992 mit beiliegendem Zahlschein zu 
begleichen! 
 
Die Mitglieder von außerhalb Österreichs bitten wir ihren Beitrag 
für 1992 über DM 45.- nach Möglichkeit in Form eines Euroschecks an 
den Herausgeber zu schicken. Alle anderen Überweisungsformen verur-
sachen zum Teil recht hohe (bis zu DM 20.-) Bankspesen. 
 
                                            Herzlichen Dank 
 
 
 
 

Membership Dues for 1992 
 
 
The Austrian DUG Members are asked for settling the memership dues for 1992 using the enclosed 
paying-in form! 
 
We invite the members from outside Austria to pay their dues of GM 45.- for 1992 using an euro-
cheque as far as possible and sending it to the editor. Each other kind of payment causes considerable 
banking charges (sometimes GM 20.-). 
                                                                                                                      Thank you 
 
 
 



   D-N-L#4  
 

L E T T E R  O F  T H E  E D I T O R   
  p 1    

 
Lieber Derive Anwender! 
 
Mit der 4. Ausgabe des D-N-L beendet die 
DUG das erste Jahr ihres Bestehens. Die wei-
terhin steigende Mitgliederzahl - derzeit 205 - 
ist ebenso erfreulich wie die Tatsache, dass uns 
immer wieder interessante Artikel erreichen. 
Trotzdem bitten wir um weitere Beiträge aus 
allen Gebieten der Lehre und Anwendung. Ich 
möchte besonders die technischen Anwender 
auffordern, uns über ihre Einsatzmöglichkeiten 
von DERIVE zu berichten. Schreiben Sie auch, 
wenn Sie Ideen haben, die Sie gerne be-
handelt wissen oder zur Diskussion gestellt 
haben wollen. 
   Auf Seite 37 finden Sie die Ausschreibung 
für eine DERIVE-Frühjahrs-Schule in Krems, 
einer netten Stadt in Niederösterreich. Wie Sie 
vielleicht wissen, hat das dafür zuständige 
Ministerium für einen Großteil der Höheren 
Schulen eine Generallizenz für DERIVE er-
worben. Die damit befassten Herren und da 
ganz besonders LSI Dr. Heugl und MR Dr. 
Szirucsek erkennen die Herausforderung, die 
die Computeralgebra für die Schulmathematik 
darstellt und wollen ihr offensiv begegnen. 
Man darf entscheidende Impulse von dieser 
Tagung erwarten. 
   Wie schon im letzten D-N-L angekündigt, 
überschreitet die DUG mit dem Jahr 1992  
offiziell die Grenzen Europas und lädt auch die 
US-DERIVE-User zum Beitritt ein. Wir kön-
nen uns schon jetzt auf den Ozean überspan-
nende Kontakte freuen. 
 
Zum Schluß will ich Ihnen noch ein fröhliches 
Weihnachtsfest sowie ein glückliches Jahr 
1992 in Gesundheit und Frieden wünschen. 
Nehmen Sie die beigelegte Diskette mit allen 
.MTH–Dateien aus D-N-L#1 bis D-N-L#4 als 
kleine Aufmerksamkeit für Ihr Interesse an der 
DUG, als Dank für Ihre Mitarbeit und zugleich 
als Bitte, auch weiterhin am Ausbau der DUG 
mitzuwirken. 
 
        Mit den besten Grüßen 
 

 
 

 
Dear Derive User, 
 
   the DUG ends its first year of existence with 
the first issue of its bulletin, the D-N-L. The 
steadily increasing number of members is as 
pleasing -–205 till now – as the fact that inter-
esting contributions are reaching the editor's 
desk again and again. Nevertheless we ask for 
further papers from all fields of teaching and 
application mathematics. I'd like to invite es-
pecially the technical users to inform us about 
their use of DERIVE. Please also write if you 
have any ideas which you want to be dealt with 
or you want to have discussed. 
 
   On page 37 you will find the announcement 
for a DERIVE Spring School in Krems, a nice 
town in Lower Aus-tria. Perhaps you know, 
that the Ministry of Education has bought the 
general DERIVE licence for a great part of 
Austria's Secondary Schools. The people being 
occupied with this task and especially LSI Dr. 
Heugl and MR Dr. Szirucsek recognize the big 
challenge which Computer Algebra performs 
for maths in school and they will face this 
challenge bold-ly. We may expect a lot of im-
portant impulses from that meeting. 
   As announced in the last D-N-L, the DUG 
will go beyond Europe's borders in 1992 and 
will invite the US DERIVE Users for member-
ship. We are looking forward to having con-
tacts reaching over the ocean in the future. 
 
      At last I wish you a Merry Christmas and a 
Happy New Year 1992 in health and peace. 
Take the disk enclosed containing all the 
.MTH-files from D-N-L#1 to D-N-L#4 as a 
little present for your interest and cooperation 
and at the same time as an invitation to partici-
pate in the further development of the DUG 
 
With my best regards 
 

 
 
 

 
 



   p 2   
 

E  D  I  T  O  R  I  A  L  
 

  D-N-L#4   
 
 
The Derive-News-Letter is the 
Bulletin of the Derive-User– 
Group. It is published at least 
three times a year with a con-
tents of 30 pages minimum. 
 
The goals of the D-N-L are to 
enable the exchange of experi-
ences made with Derive as well 
as to create a group to discuss 
the possibilities of new me-
thodical and didactic manners 
in teaching Mathema-tics. 
 
Editor: 
Mag. Josef Böhm 
A-3042 Würmla 
D'Lust 1 
Phone 43-(0)2275/8207 
Austria 

 
Contributions: 
 
Please send all contributions 
to the above address. Non-Eng-
lish speakers are encouraged to 
write their contributions in 
English to reinforce the inter-
national touch of D-N-L. It 
must be said, though, that non-
English articles will be warmly 
welcomed none-the-less. Your 
contributions will be edited 
but not assessed. By submitting 
articles the author gives his 
consent for reprin-ting it in 
D-N-L. The more contributions 
you will send to the Editor, 
the more lively and richer in 
contents the Derive-News-Letter 
will be. 

 
 
 
 
Preview:  Contributions for the next issues:  

Finding a gradient; 

Zur Problematik des Einsatzes von DERIVE; 

Cyclomania (Hypotrochoids & Epitrochoids); 

Two Underground Tunnels (applied Geometry); 

Module on sequences and series with Derive (Part 2) 

 
 
                                                                              (will be published March 92) 
 
 
 
 
 
  

 
Impressum:  
Medieninhaber: DERIVE User Group, A-3042 Würmla, D´Lust 1, AUSTRIA 
Richtung: Fachzeitschrift 
Herausgeber: Mag.Josef Böhm, Adresse wie oben 
Herstellung: eigene Vervielfältigung 
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D E R I V E  –  User  -  Forum 
 
 
Waclaw Sadowski, Bukowiec 

Dear Sir, 
My name is Waclaw Sadowski and i am thirty.three years of age. I live in a small village called Male Konskie in 
the central region of Poland. I am a higher school graduate and I am a lecturer of mathematics in Secondary 
School. 
I am very much interested in getting know more on the Derive User Group and its bulletin and that's why I've 
made up my mind to write to you. Recently I have been successful in entering into contacts with some scientists 
who involve in research on new developments in mathematics and mathematics teaching. 
The secondary schools in Poland are secondary schools which provide comprehensive secondary education. The 
graduates of this school, after having finished the last (fourth) grade, obtain certificates of secondary education 
and after having passed the final examination (so-called 'maturity') are entitled to apply for admission to the 
institutions of higher education. The four-year secondary general schools realize plans and curricula of teaching 
approved by the Ministry of National Education. 
We Polish scientists need help from specialists from western countries to help Poland in its new form to integrate 
into the western part of Europe. I shall much appreciate if you could kindly take action to provide me with in-
formation on Derive and one free of charge your bulletin. I look forward to hearing from you before long. 
 
                                                                                                                   Yours sincerely 
 
 
Matija Lokar, Kranj 

Dear Editor! 
Few days ago I got the Derive news letter#1. I found it very interesting and I would like to join the Derive user 
group. I would do that immediately as I manage the way to pay Annual Membership Dues, as it is now almost 
impossible to do, because of the situation in our country. 
[..some comments to the equation in D-N-L#1, which leads to x7 - 1 = 0] 
   Although I mostly work with Mathematica, I am very interested in Derive and found it very good. In the last 
half a year, me and a couple of friends tried to put Derive on the list of software, specially convenient for use in 
secondary schools. We hope we manage that and to the end of year it is expected that all of 135 secondary 
schools will receive a copy of Derive for inspection. We also plan to establish special courses about Derive. 
Therefor I ask you for possible help. Any suggestions, experience with training for use of Derive would be appe-
ciated. 
 
                                                                                                                                With best regards 
 
 
D-N-L: We are very glad that the DUG might reach the young democratic states in Eastern Europe. If there are 
any DUG members who want to establish contact with Mr. Sadowski or Mr./Mrs. Lokar, then please write or 
call for their addresses. 
 
 
Herbert Appel, Schweinfurt 

[...] Zusätzlich erhalten Sie von mir mit der Bitte um Veröffentlichung einen weiteren Artikel zur Problematik 
des Einsatzes von DERIVE im Mathematikunterricht. Der Artikel kann, falls notwendig, sinnvoll gekürzt wer-
den; ein vollständiger Abdruck (vielleicht schon im DNL#4) ist mir jedoch am liebsten. 
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Verbesserungsvorschläge zum  DNL: 

- könnte dicker sein. 180 Mitglieder müßten eigentlich eine ganze Menge Artikel produzieren. Ich wäre unter 
Umständen auch bereit, einen höheren Mitgliedsbeitrag zu bezahlen. 

- Bitte an die Mitglieder, bei Einverständnis der anderen Mitglieder, Namen und Adressen weitergeben, um 
miteinander in Kontakt treten zu können. 

- Ich benutze Derive auf meinem Atari ST mit ATonce 16Mhz. Derive spricht hier im Gegensatz zu "Cabri-
Geometrie", die VGA-Graphikkarte nicht an. Außerdem kann ich trotz GRAPHICS aus DOS 4.0 mit PRTSCR 
keine Hardcopy auf meinem NEC P6 machen. 

- Bitte nicht mit Klammern beim DNL sparen. DNL#2 war noch mit 3 Klammern am Auseinanderfallen gehin-
dert. (DNL#3 nur noch eine Klammer). 

With all - autre chauses - sono contento - weiter so – do swidanje 
Im Rahmen der Völkerverständigung. 

 

D-N-L: What is the opinion of the DUG-members? In the next issue we will publish the complete list of the 
DUG, exept those who have informed me not to be mentioned by name. 

I hope that the 202 members of the DUG are as productive as Mr. Appel thinks them to be. 

The bad finishing of DNL#3 was caused by lack of time. Sorry, hope to do better now! 

Mr. Appel has sent an article concerning the problems of using DERIVE when teaching mathematics. It will be 
published in DNL#5. 

 

Robert Setif, Annemasse 

1. Pourquoi le chronometrage de certains calculs dans un environnement pratiquement identique donne-t-il 
parfois des résultats trés differents? Voir la fonction mod. 

2. La fonction mod de DNL# 2, p 15 m'a surpris. Elle ne fonctionne pas avec par exemple 

               vector(mod(k,2),k,0,24)           Simplify or Approx 

3. Voudriez-vous des fonctions aussi simples que  MOD_IT (k,n):=iterate(a-n,a,k,k/n) ou des 
fonctions ADD MUL DIV recursives trés peu performantes, mais interessantes pour apprentis-
programmeurs? 

4. Si cela peut etre utile a quelqu'un, je peux poursuivre le calcul (a la main!) des fractions continues au -delá 
de √700, mais je préférerais qu'on me trouve une fonction de Derive (ou de MuMATH) qui trouve 
automatiquement les résultats. 

5. Pourriez-vous approfondir le sujet des erreurs pour les fractions continues successives? C'est ma partie 
faible ! 

6. Auriez-vous d'autres sujets a me proposer qui ne demandent pas un trop grand quotient intellectuel, car je 
commence a ètre .. usé..(et je travaille tout en gardant mon petit fils de 8 mois!)? 
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7. Je ne suis pas equipé pour le bulletin electronique for Derive users. Pourriez-vous publier dans DNL les 

réponses les plus interessantes ? 

 
8. Y a-t-il une nouvelle version de Derive en chantier ? Avec quelles ameliorations ? 

 
9. Etes-vous utilisateur (ou l avez vous été) de Mumath ? Des fichiers Mumath vous interessent-ils ? 

A mon avis, Mumath est plus interessant que Derive pour les calculs sur  N et Q.  

 
 
Souhaits pour nouvelles versions de Derive  

 
1. Option notation: Affichagé‚ par tranches de 3  chiffres.  

Par exemple 210  = 1 048 576 
                         √2  = 1.414 213 562... 

 
2. Option notation: affichagé dans tout l'. écran.                                   

 
3. Option mute:Signal sonoré a la fin d'un calcul, car c'est penible d'attendre (meme si pendant ce temps je 

peus calculer des fractions continues!) des résultats qui viennent après plus de 1 heure ou mème plusieurs 
minutes. 

 
4. Option break: (comme dans MuMATH) qui permette d'interroger certaines variables, de comprendre des 

erreurs, de connaitre la situation quand on est  "dans le noir". 

 
5. Plus de possibilités de programmation , bien qu'il y ait d'ja un progres considerable depuis Derive 1., et ceci 

avec très peu de mots nouveaux (Vector, Iterate, if). 

 
6. Passage Mumath <--> Derive comme il y a Fortran <--> Derive,  au moins pour les résultats numeriques et 

les polynômes. 

 
7. Introduction de LISTES : Plus souples que les vecteurs, avec pop et push et liste de listes qui n'auraient pas 

forcement la mème dimension. 

 
8. Possibilité d'une nouvelle sorte de fonction qui afficherait les résultats a mesuré a chaque appui sur une 

touché speciale (par exemple "space" ASCII 32 ) au lieu d'attendre que par exemple le vecteur soit tout 
calculé avec les risques de "memory full". 

 
Avec mes meilleurs sentiments  

 
Bon vacances 

Merci pour les améliorisations de mon fichier SYRACUSE. 
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Here you can find some improvements to the SYRACUS.MTH file from D-N-L#3. 

 
In 1991 it was necessary to produce one´s own mod-function mod(x,y), (see DNL#3). 
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              ……………….. 

 
              ………………... 

 
 

  
Plot of expression #22 
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This time monsieur Setif opens his treasure box to show us some spirals and polygons. Until expression #5 work 
with rectangular coordinates, then switch to polar coordinates. (More graphs on p 38)  

 
 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 

       Try to find the N-Star! 
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With ITERATES to CHAOS 

(Part 2) 
Dr. Felix Schumm, Stuttgart 

 
3.  Gekoppelte Iteration von zwei Variablen x1 und x2 

3.1   Allgemeine Betrachtungen 

Wir wollen einen Urbildpunkt P(x1, x2) abbilden auf einen Punkt P'(x1′, x2′). Die dazu nötigen Abbil-
dungsvorschriften seien durch zwei Funktionen f1 und f2 in folgender Weise gegeben: 

      x1′ = f1(x1, x2) 
      x2′ = f2(x1, x2) 
 
Wiederholen wir die gleiche Abbildungsvorschrift auf P′', so ergibt sich: 

      x1" = f1(f1(x1, x2),f2(x1, x2)) 
      x2" = f2(f1(x1, x2),f2(x1, x2)) 
 
Diesen Prozess können wir nun n-mal wiederholen: 

            x1′                 =               f1(x1, x2) 
            x2′                 =               f2(x1, x2) 
 
 
                              x1 := x1′                              n mal wiederholen. 
                              x2 := x2′' 
 

Knapper lässt sich das Verfahren in Vektorform darstellen:  

                                 x′             =              F(x) 

                                                                                             n mal wiederholen. 

                                            x  :=  x′ 

worin x ein Vektor mit zwei Komponenten [x1, x2] und ebenso F ein Vektor mit zwei Komponenten 
[f1, f2] sein muss. 

3.2   Umsetzung in DERIVE 

Im Befehl ITERATES(F,x,x0,n) muss nun x0 als Startvektor, zB [0,1] eingegeben werden 
und F muss einen Vektor der Form [f1, f2] mit den skalaren Funktionen f1 und f2 darstellen. 

Das Ergebnis sollte dann in Form einer Matrix ausgegeben werden, die je nach Iterationszahl folgende 
Gestalt hat: 

                                                        [[x1, x2],[x1′, x2′],[x1′′, x2′′],......], bzw  

1 2

1 2

1 2
... ...
... ...

x x
x x
x x

 
 ′ ′
 ′′ ′′ 
 
  

 

Die Wirkung des ITERATES-Befehles machen wir uns am besten an immer komplizierteren Beispie-
len klar: 
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1. Beispiel: 
 

2. Beispiel: 

 

weil f = 3x ein Vektor ist. 

3. Beispiel: Setzt man für f = a ⋅ x + c ein,worin a eine Matrix [aij] und c ein Translationsvektor ist, 
so kann man bequem eine affine Abbildung iterieren. Wir geben zB ein: 

 

Nach SIMPLIFY ergibt dies: 

 
Wählt man spezielle Zahlenwerte für a, c und 
für [x1, x2], dann sieht das so aus: 

 
Viele Abbildungen sind aber nicht durch affine Transformationen ausdrückbar. Für diesen Fall muss 
man ein komplizierteres Verfahren einschlagen. Zunächst definieren wir allgemein die Funktionen, die 
unsere Abbildung liefern sollen. 

 

Dann definieren wir zwei Hilfsfunktionen G1(x) und G2(x), die in die Funktionen F1 und F2 die 
Komponenten x1 und x2 des Vektors x = [x1, x2] einlesen. 

 
Der ITERATES-Befehl lautet mit diesen Hilfsfunktionen 

ITERATES([G1(x), G2(x)], x, [x1, x2], 2). 

und liefert erwartungsgemäß 
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Die Hilfsfunktionen können wir auch gleich in den ITERATES-Befehl mit aufnehmen: 
ITERATES(F1(x , x ), F2(x , x ), x, x , x , n) 
             1   2       1   2       1   2 
 
Es ist gegebenenfalls zweckmäßig, sich dies nun in einem Hilfsfile "ITERATIO.MTH" abzuspeichern, 
das etwa folgendermaßen aussehen könnte: 
(In einer MTH-Datei können keine Textboxes gespeichert werden, Kommentare wie in #1, #2 usw. 
müssen unter " geschrieben werden.) 
 
It makes sense to save this in a utility file ITERATIO.MTH, which could look like as follows: 
(In a  MTH-file textboxes cannot be saved, so include comments (#1, #2, etc) under quotes ″.) 

 
 

3.3    Beispiel einer Anwendung 

Volterra-Zyklus zwischen Räuber- und Beutetieren  Predator – Prey – Cycles  

Für Räuber – Beute – Simulationen gilt das Gleichungssystem: 
Predator-Prey-simulations can be described by: 

1 1 2

2 2 1

(1 )
(1 )

x x d c x
x x a b x

′ = ⋅ − + ⋅
′ = ⋅ + − ⋅

  mit x1 = Räuberzahl und x2 = Beutezahl (x1 = predators, x2 = prey) 

Dabei haben die Parameter die folgende Bedeutung: 

a ...... Wachstumsrate der Beutetiere (growth rate of prey) 
b ...... Verlustrate der Beutetiere (loss rate of prey) 
c ...... Regenerationsrate der Räuber (rate of regeneration of predators) 
d ...... Energieverlust der Räuber (loss rate of energy of predators) 
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Nachdem wir die Datei ITERATIO.MTH geladen haben, geben wir ein: 

 
 

und erhalten nach SIMPLIFY die nebenstehende Matrix. 
 
3.4    Graphische Darstellung 

Für unser Iterationsproblem haben wir in Abschnitt 3.3 die Lösung in result_matrix(x0,n) 
zusammengefasst. Sie lieferte eine Matrix in der Form 
 

′ ′

′′ ′′

′′′ ′′′⋅ ⋅ ⋅ ⋅ ⋅ ⋅
⋅ ⋅ ⋅ ⋅ ⋅ ⋅⋅ ⋅ ⋅ ⋅ ⋅ ⋅
⋅ ⋅ ⋅ ⋅ ⋅ ⋅

   
   
   
   
   
   
   
   
   
     

11 12 1 2

21 22
1 2

31 32

1 2
41 42

1 2

n+1,1 n+1,2

e e x x

e e
x x

e e
x x

e ee:= =

x x

e e

 

Wenn man die entwickelten einzelnen Komponenten von x1 und x2 in Abhängigkeit von der Iterations-
tiefe graphisch darstellen will, muss man daraus, wie in Abschnitt 2.4 besprochen, Matrizen in folgen-
der Form erzeugen: 

und

   
   
   
   
   
   
   
   
   
      

" " " "
" " " "

11 12

21 22

31 32

41 42

n+1,1 n+1,2

0 e 0 e

1 e 1 e

2 e 2 e

3 e 3 epic_1:= pic_2:=

n e n e

 

Mit m SUB i SUB j = m↓i↓j – m ist die Matrix result_matrix(x0,n) – lassen sich beide 
Bilder mit dem VECTOR-Befehl durch eine Schleife einlesen. 
 
Expression to extract data for plotting the devel-
opment of predator population (pic_1) and prey 
population (pic_2). 

 
 
Wir prüfen dies nach, indem wir eine Matrix m eingeben: 
 
 
 
 
 
 
                        ... und erhalten richtig nach SIMPLIFY: 
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Die Daten für unsere Simulation sind / Data for our simulation are  
 
[a ≔ 1,b ≔ 0.002,c ≔ 0.00001,d ≔ 0.08,n ≔ 100,x0 ≔ [450, 8050]] 
 
pic_1(x0,n) 
 

 
 
pic_2(x0,n) 
 

 
 
Eine andere Wahl für die Parameter liefert eine mehr oder weniger zyklischen Verlauf der Populati-
onsentwicklung / Another choice of parameters shows a cyclic up and down of both populations.  
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Anmerkung des Herausgebers: 
In der Zeitschrift "Spektrum der Wissenschaft" (Scientific American) fand ich in 2/84 und 2/85 jeweils 
einen Artikel über das, von Herrn Schumm bearbeitete Thema. Dabei wurden zwei interessante Gra-
phiken gegenübergestellt: 

 
Furs of Snowhare and Lynx caught in Canada between 1850 and 1900 (above) 
and solution of the associated differential equation (below). 
 
Pictures from "Scientific American", 1984 and 1985. 
 
Dies ist die exakte Lösung der zugehörigen Differentialgleichungen: 
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I enclose a short article on the use of DERIVE to find inverse Laplace Transforms which may be of use 
for the Bulletin of the DERIVE User Group. I have deliberately left it open-ended with some sugges-
tions for further investigations. 
                                          Yours faithfully 
                                             J.V. Royle 
 

Inverse Laplace Transforms using DERIVE 
J.V. Royle, Leicester 

 

We wish to find the inverse Laplace Transform, 1 ( )
( )

−  
 
 

P sL
Q s

, of a rational function ( )
( )

P s
Q s

, where  

deg P(s) < deg Q(s). The usual elementary method is to 
 
(i) factorise Q(s) into real linear and quadratic factors, 

(ii) express ( )
( )

P s
Q s

 in terms of Partial Fractions, 

(iii) use tables of standard Laplace Transforms to find the inverse Laplace Transform of each of 
the Partial Fractions. The Expand command in DERIVE can be used to find the Partial Fraction 
expansion required in step (ii), provided the denominator factorises into real linear and quad-
ratic factors with rational coefficients. 

 

Example Find 
2

1
3 2

4 2
2 11 18 9

−  + −
 + + + 

s sL
s s s

. 

 
 
Simplify>Expand delivers the factorisation. There is no need to first factorise the denominator. 
 

Using the standard inverse Laplace Transform 1 1−   = − 
atL e

s a
, we get 

3
2 32

1
3 2

4 2 23 5 5
2 11 18 9 6 6 2

− − −
−  + −

= − − + + + 

t
t ts s e e eL

s s s
 

 
Among the User Contributed files you can find LaplaceTransforms.dfw which according to its header 
computes the inverse Laplace transform of  the function f(s) in terms of t. The author of this file is our 
friend Terence Etchells, who revised it first time in August 2003.  
So we load this file as a Utility file and try to find the Inverse Laplace Transform of the above expres-
sion to check this calculation – and to check the file, of course. 
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Problems with this method arise if 

(i) there are Partial Fractions with quadratic denominators,  

 e.g. for 3 2

3 5
6 16 16

+
+ + +

s
s s s

 DERIVE gives the Partial Fraction expansion 

 
 

Using standard inverse Laplace Transforms of the form 

1
2 2 cos( )

( )
a ts aL e bt

s a b
− − +

= + + 
 still leaves some manipulation to be done which is not easily 

performed with DERIVE. 
 
(ii) the denominator, Q(s), does not factorise into linear and quadratic factors with rational coeffi-

cients. 

These problems can be surmounted by the following method, which depends on the result if Q(s) has a 

simple factor of (s – a) then the Partial Fraction expansion of ( )
( )

P s
Q s

 contains a term 
−
A

s a
, where 

( )
( )

=
′

P aA
Q a

. 

Hence if Q(s) is an nth degree polynomial with n simple roots a1, a2, ..., an, real or complex, and  
deg P(s) < n then: 

 
1

( )
( )

=

=
−∑

n
i

ii

AP s
Q s s a

, where ( )
( )

=
′

i
i

i

P aA
Q a

, then using 1 1−   = − 
atL e

s a
 the final result is 

 

1

1

( )( ) .
( ) ( )

−

=

 
=  ′ 
∑ i

n
a ti

ii

P aP sL e
Q s Q a  

 

Hence to find 1 ( )
( )

−  
 
 

P sL
Q s

, where Q(s) has only simple roots, the procedure in DERIVE is: 

(i) define a function    ILT(a):=LIM(p/dif(q,s),s,a)*exp(a·t) 

(ii) author the numerator and denominator as variables p and q 

(iii) Solve q = 0, best to use Mixed Mode 

(iv) assuming there are as many different solutions, a1, a2, ..., an as the degree of Q(s) then the 
roots are all simple, find the inverse Laplace Transform by authoring and simplifying 

ILT(a1) + ILT(a2) + ... + ILT(an). 
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There is no problem with complex roots since, if ( )
( )

P s
Q s

 is real, complex roots occur in complex conju-

gate pairs and DERIVE automatically expresses complex exponentials, which will occur in the ILT-
sum as complex conjugate pairs, in terms of real trigonometric functions. 

In the following examples it is assumed that the ILT-function has been defined as above and that 
Precision Mode has been set to Mixed. 

 
 
Example 
 

 Find 1
3 2

3 5 .
6 16 16

− + 
 + + + 

sL
s s s

 

 
 
We check again applying InvLaplace: 

 
So in fact this tool seems to be very reliable! 
 

Example Find 
2

1
3 2

4 2 .
3 5 7

−  − +
 + + + 

s sL
s s s

 

 
These roots indicate that q can not be factorised into linear and quadratic factors with rational coeffi-
cients. 
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So to find the inverse Laplace Transform: 

 
 
Once more I called the new user contributed function 

 
 
I interrupted simplifying after more than 5 minutes and then achieved a result by approximating the 
expression – but it was quite different to the result obtained by using J V Royle´s method (compare the 
two expressions!). I wrote a mail to Terence and asked for advice. His answer was an update of 
LaplaceTransform.dfw from 9 November 2004 which not only simplifies the expression within 
0.77 sec to a bulky expression but also approximates to the same result as given above: 

 
 
(Terence says: Note that the inversion has not returned the original expression. However a plot of the 
original function and the inversion of its Laplace transform show that they are indeed the same func-
tion. This latest version of LaplaceTransform.dfw is among the files associated to revised DNL#4. 
Many thanks Terence for your immediate reaction.) 
 
 
Further extensions of this method are possible: 

(i) Find the formula for the coefficients, A and B, in terms of P(s) and Q(s) and their derivatives, 

for the Partial Fractions 
2( )

A B
s a s a

+
− −

, corresponding to a double root s = a of Q(s) = 0. 

Then define a function ilt2(a):=A exp(a t) + B t exp(a t) in DERIVE using the for-
mulae found for A and B. 

(ii) For Laplace Transforms which are not rational functions, finding a Padé approximation valid 
for large s and inverting this to get an approximation to the inverse Laplace Transform valid 
for small t. 
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Joint Venture DERIVE und Cabri 
im Mathematikunterricht 

Herbert Appel und Richard Brand, Schweinfurt 
 
1. Einleitung 

Das Erscheinen von Programmen für interaktive Geometrie und symbolische Algebra, die eine neue 
Epoche für den Mathematikunterricht einzuleiten scheinen, erzeugte in letzter Zeit eine Flut sicherlich 
nötiger und guter Artikel (Schuhmann, Engel, Weigand, Weth u.a.) in didaktischen Zeitschriften. Bü-
cher zu diesem Thema sind momentan noch Mangelware, was sich aber sicher demnächst ändern wird. 
Ein Mangel haftet jedoch all diesen Betrachtungen an: zum einen beschränken sie sich meist nur auf 
eine Art von Programm, also entweder auf den Einsatz von z.B. DERIVE oder von z.B. Cabri im MU; 
zum anderen werden darin relativ einfache und grundlegende Beispiele behandelt. Die dadurch mögli-
che Verquickung von Algebra und Geometrie findet nicht statt. 

Mit der folgenden Aufgabe wollen wir speziell dem Lehrer (direkt an der Front) ein Beispiel an die 
Hand geben, wie er DERIVE und Cabri zur Bearbeitung einer etwas anspruchsvolleren Aufgabe kombi-
niert in seinem Unterricht einsetzen kann. 
 
Appearance of dynamic geometry and computeralgebra programs which seem to open a new era for math educa-
tion initiated a lot of interesting papers in the last time (Schuhmann, Engel, Weigand, Weth ao). All of these arti-
cles are mostly restricted to only one of these programs and tackle very simple examples. There is very little co-
operation between algebra and geometry. 
By presenting the following problem we will offer an example how to use Derive and Cabri treating a more de-
manding task in classroom. 
 
2. Methodische Hinweise 

Folgende Aufgabe könnte Inhalt einer Übungsstunde in der 9.Klasse der Sekundarstufe I sein. Sie ist 
beispielhaft für das induktiv-deduktive Vorgehen beim Finden einer Lösung. 
 
Voraussetzung ist, dass ... 

... die Schüler bereits im Umgang mit der Bedienung der beiden oben erwähnten Programme versiert  
    sind oder 

... eine Systemkombination IBM-kompatibler AT + Panel an der Schule existiert. 
 
Um ein Arbeiten mit Bleistift und Papier kommt der Schüler allerdings schon der Anschaulichkeit 
wegen nicht herum. 
 
3. Die Aufgabenstellung 

Mit den Vektoren AB und ADn ist eine Schar gleichschenkeliger Trapeze gegeben. 

Dabei gilt: 
4 4

: (2 |1); (4.5 | 0.5) und
2 2.5n n n

z
AB C D A B AD

z
−

= =
+

 
 
 

. 

Vectors AB and CnDn and define a family of isosceles trapeziums: AB = CnDn: A(2|1); B(4.5|0.5) and 

ADn=
 
 
 

4z - 4

2z + 2.5
. 

Fragen / Questions: 

a)   Was lässt sich über den geometrischen Ort der Punkte Dn aussagen? 
b)   Welche Kurve beschreiben die Punkte Cn? 
 
a)   Which is the locus of points Dn? 
b)   Which is the curve described by points Cn? 
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Lösungsstrategie: 

Um den geometrischen Ort der Punkte Dn zu gewinnen ist eine Parameter-Transformation (mit DERIVE 
oder per Hand) durchzuführen. Diese ergibt 

9
2

n

x
AD x= +

 
 
 
 

; die Punkte Dn liegen auf einer Geraden (Frage a). 

Um sich einen Überblick über den geometrischen Ort der Punkte Cn zu verschaffen wird mit Cabri das 
(veränderbare) gleichschenkelige Trapez konstruiert. Da in Cabri eine Anfgabe der genauen Punkt-
koordinaten nicht möglich ist, kann man sich durch Verwendung herkömmlicher Zeichenhilfsmittel 
(Zirkel, Lineal und Papier) einen groben Überblick über die Lage der Punkte und Geraden im 
Koordinatensystem verschaffen, eine Idee für die Konstruktion der Trapeze aus den Angaben holen 
und diese dann mit Cabri durchführen. 

 

 
Parameter transformation leads to the answer of ques-
tion a): points Dn are lying on a line. 
 
To obtain an impression about the locus of points Cn 
we use Cabri to produce the dynamic variable trape-
zium. 
 
We show the “historic” screenshot from 1991 showing 
one of the first German Cabri versions. 

 
Recent Cabri versions 
give a presentation of 
the locus. We can locate 
pts A and B according to 
the given coordinates. 

You can see that we 
draw the perpendicular 
bisector of ADn. 

Dn is moveable on the 
line. 

Reflecting point B with 
respect to this bisector 
gives point Cn. 

  

zu b) Konstruktionsbeschreibung 
 
          Zeichne Gerade g durch A und B, 
          zeichne beliebige zweite Gerade, die g schneidet (Skizze) 
          Punkt Dn liegt auf der zweiten Geraden, 
          zeichne Strecke ADn, 
          konstruiere Mittelsenkrechte h zu ADn, 
          spiegle B an h. Es ergibt sich Cn, 
          bewegen des Punktes Dn zum Zeichnen der Ortlinie. 
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Man erkennt, dass die Kurve eine unbekannte Form (keine Gerade, Parabel, Hyperbel usw.) ist. Eine 
algebraische Beschreibung der Ortslinie ist sinnvoll. Die gewonnene Ortslinie wird vorsorglich zum 
späteren Vergleich ausgedruckt. 

It is obvious that the curve shows an unknown form (no straight line, parabola, hyperbola, etc). It makes sense to 
look for an algebraic description of the locus. we print the locus for later comparison. 

Zur Veranschaulichung von bekannten und gesuchten Größen dient die Skizze auf dem Blatt. Die Um-
formungen werden mit DERIVE durchgeführt. Follow the sketch. 
 

 
Nach längerer Rechnung ergibt sich der Schnittpunkt der beiden Geraden g ∩ h  S(-31/7; 16/7), deren 
Schnittwinkel α ≈ 37.875° und AS ≈ 6.556 LE.  Der Neigungswinkel der Geraden AB ist ≈ -11.31°. 
 

Aus dem Sinussatz folgt:               6.556 sin37.875( )
sin(37.875 )

b β
β

°
=

° +
                                    (1) 

                       außerdem                6.5AB =                                                          (2) 

                                und                 ( ) ( ) 2 cosc b ABβ β β= +                                    (3) 
 
und damit     (4.5 ( ) cos(11.31 ), 0.5 ( ) sin(11.31 ))nC c cβ β β β= − ⋅ ° + + ⋅ ° +             (4) 

We apply the sine rule to express length b depending on angle β and find easily an expression for the parallel 
side c(β). Using the coordinates of point B we derive the coordinates of Cn which describes the locus in its pa-
rameter representation with parameter β.  

To keep work as easy as possible we use the Substitute command three times, which leads us to a huge and 
bulky expression. Students are very happy that they didn´t need find it by manual calculation. Derive allows arbi-
trary long function expressions and is able to plot graphs for functions given in parameter form. 

 
Um den Schreibaufwand gering zu halten, kommt uns DERIVE mit dem Befehl Substitute sehr ent-
gegen. Dreifaches Anwenden ersetzt (1) und (2) in (3) und (3) in (4). 

Heraus kommt ein Riese von einem Term, von dem die Schüler froh sind, dass sie ihn nicht durch 
schriftliches Umformen herleiten mussten (siehe #34 im Listing). 

DERIVE bietet uns nun gegenüber anderen bisher eingesetzten Kurvenplotprogrammen noch zwei Be-
sonderheiten: 

- es erlaubt die Eingabe beliebig langer Funktionsterme 
- es kann auch Graphen von Funktionen zeichnen, die in Parameterform gegeben sind. Das nutzen wir  
  schamlos aus. 
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Der Vergleich der von Cabri gezeichneten 
Punktmenge und dem Graphen, den uns DERIVE 
zeichnet. ergibt eine ausreichende Übereinstim-
mung und ermöglicht dem Schüler eine tiefere 
Einsicht in die Zusammenhänge zwischen Al-
gebra und Geometrie. 
Comparison of the Cabri- and the Derive results 
shows an acceptable correspondence and might 
lead the student to a deeper insight into the connec-
tions between algebra and geometry. 

 

Die DERIVE Ausarbeitung / The Derive session 

      

 

  
4. Schlussbemerkung 

Wir hoffen, dem geneigten Lehrer (Leser) einen Eindruck von der Mächtigkeit, die eine Kombination 
der beiden Programme darstellt, vermittelt und ihn zum Weiterdenken in dieser Richtung angeregt zu 
haben. 
Ein Programm, das die Fähigkeit von DERIVE und Cabri in sich vereinigt ist unseres Wissens nach 
noch nicht auf dem Markt, aber es wird dem Vernehmen nach daran gearbeitet. 

Concluding comment: We hope that we were able to give an impression of the power which is represented by a 
combination of these two programs and that we inspired some of you to develop more ideas and concepts in this 
direction. It would be great to have a program which combines the capabilities of both tools. 

By rewriting this article from 1991 using the tools of 2004 I found some nice things.  
Please follow the next page(s)! Josef 
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First of all I used Cabri II to find some other loci varying the position of the underlying basic 
lines. 

  
 

I sat in the train on my way to give a two-days course on the use of CAS-TIs and DERIVE 
and wanted to tackle Herbert´s problem without using trig functions. The coach was full and I 
could not open my notebook. So I took my Voyage 200 and started calculating. 

The idea was to draw a line parallel to ADn through point B. Then draw a circle with center Dn 
and radius AB. The intersection point should give Cn. Finally I tried to find a reasonable alge-
braic form for the locus. 

 

You can see the most important part. Two facts are of special interest: 

o The result is a rational expression and more interesting 

o We have two loci, one of them appearing as line with the same slope as the locus of Dn!! 

I plotted all graphs on the TI using Parametric Mode, which gave a satisfying result. 

 

It was a long ride, so started Cabri on the Voyage 200 and reproduced my idea using dy-
namic geometry in full agreement with Herbert Appel´s idea of combining the two poweful 
tools and also applying our highly appreciated “Window-Shuttle” principle. 

 

 

On the left you can follow 
how to produce the locus. 
There are two intersection 
points! 

One of them giving the trape-
zium – the other one giving a 
???? 
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Strange things happen plotting the locus of the trapezium point (see right above): There is a 
flaw in the locus and it changes from the curve to the line. This is caused by a deficiency of 
Cabri, because it does not “keep” the right point by passing the position when both quadran-
gles coincide (in form of a rightangle). Adding the locus of the second intersection point gives 
the missing parts and now we can see both graphs. 

                        
I saved my Voyage 200 session from the Homescreen into a text file appeltxt and hoped 
to be able to tranfer the calculation to Derive 6! I added some comments in the text file and 
closed with four lines which should give the parameter form in Derive. Plotting them in the 
2D-Plot window should immediately give the graphs. 

                      
Having arrived in my hotel room in St. Johann/Salzburg I opened the notebook, connected it 
with the V 200 and launched Derive 6.10 and hoped that InterConnectivity would do it. 

I issued File>TI Handheld>Import from and typed in appeltxt. Transfer started and: 

 

 

It seems to work. I receive the correct – both loci and should be satisfied (next page). In-
specting the Derive procedure more accurately you will find quite another result for the solu-
tions of the important equation which delivers the x-values of the intersection points (see 
expr #30). 
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Removing the abs from expression #30 and simplifying once moreI obtain the same expected 
expressions. (See the end of the page for another way to obtain the expected result.) 

 
In this case InterConnectivity was very helpful for me. However, it must be said that this tool 
is not perfect at the moment. You have to consider carefully how to use the |-operator on the 
TI to have a correct translation in Derive. I was said – and from my experience with the de-
veloppers I have no reason to doubt – that the programmers are busy to improve InterCon-
nectivity between the CAS-TIs and Derive. 

Having used successfully InterConnectivity I wanted to introduce slider bars to have a dy-
namic Derive which is very close to Dynamic Geometry and forms a useful link between al-
gebraic and graphic representation forms. 

  

This is a way to overcome Derive´s solution of equation #29 including the absolute values: 
Factor the expression and then investigate the factors to get the two solutions. 
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Set Polar Coordinate System 
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Module on Sequences and Series 
with DERIVE, Part 1 

David E. Hodgkinson, Liverpool 
ITERATION 
 

Iteration is a method of repeated calculation that has become very important because computers 
can iterate quickly and accurately. The process of counting can be represented as an iterative process 
by starting at 1 and repeatedly adding 1. One mathematical way of writing this is n:= 1 and  n ← n + 1. 
This means that n is initially assigned to 1 then repeatedly increased by 1. Usually a way of stopping 
the repetition is included, either by saying how many times the assignment is repeated or providing a 
condition to stop the repetition. 

DERIVE has various functions that provide iteration facilities. To produce a list of the first twelve 
positive integers use the function ITERATES with four arguments. Commas separating the arguments 
of a function must be typed. Hence typing the following instruction should produce the associated list 
of integers. 

 
is obtained because the second argument of iterates is updated by the assignment to the first argument 
i.e.  n ← n + 1, the third argument is the initial value of n and the fourth argument is the number of 
iterations required. Hence changing 1 to 0 in iterates gives a list of 13 consecutive integers beginning 
with 0. It is fairly obvious that as the number of iterations increases the final value in the list will in-
crease, this is an example of a divergent iteration. 
 
Another example is the assigment 

1 2
2

x x
x

← + 
 
 

      starting with x = 1 

the first six values of this iteration are found from 

 
 

However, the list of longer and longer fractions is not very informative. Since iteration is mainly used 
for numerical calculations, to get decimal approximations use the approx-button (≈): 

 

i.e. approximating the fractions (or see below for how to repeat the procedure in approximate mode) 
shows that the iteration is settling to 1.414213. This is recognisable as √2 to 6 decimal places. Notice 
that this iteration is approaching a limiting value as the number of iterations increases, this is an exam-
ple of a convergent iteration. 
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There is also a function ITERATE (notice no final 'S') that will just return the final value re-

quested by the value of the fourth argument. 

 

To work in generally in Approximate Mode set in the Options>Mode Settings> Simplifica-
tion>Precision to Approximate and in Output>Notation to Decimal. 

 

 

If you suspect that an iterative sequence is convergent you can use ITERATES without the fourth 
argument and DERIVE will automatically stop when two iterates are the same to the current precision 
so 

 
since DERIVE stores its numbers in rational form the equivalence of the last three iterates is due to 

rounding; only the last two have the same fractional form. 

 
If you have been working in approximate mode do not forget to return to exact mode with 

 

 

Exercises 

1. Repeat the above iteration with  
1 3
2

x x
x

← + 
 
 

, starting with x = 1, 

(this is usually written 1

1 3
2n n

n

x x
x+ = +

 
 
 

 to find the square root of 3, to 9 decimal places. 

Can you modify the command to find the square root of 4, 5, 6? 
What would be the formula for the square root of N, where N is a positive integer?  
Try your formula on N = 107 + 1.  
Could you think of a way to speed up the convergence? 
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2. Try the iteration   1 2

1
2n n

n

N
x x

x+ = +
 
 
 

, for N = 27, 8, 4, 2, 3. (x0 = 1). 

What value does this iteration converge to for given N? 

3. Try the iteration   2
1 2n n nx x N x+ = − ⋅  

where N = 2, 3, 4, 5, 6 and the initial value of x lies between 0 and 1. What is the value of this it-
eration for different N? 

 
4. Find √2 for 10 and 20 decimal places to see the speed with which the convergent answer is 

reached. If you have been in approximate mode, do not forget to return to exact mode using the 
above instructions. 
What value does this iteration converge to for given N? 

 
 
SEQUENCES AND SERIES 
 

In the previous examples one list had the values 1,2,3,4, whilst the other had to 4 decimal places 
the values 1, 1.5, 1.4166, 1.4142, 1.4142. Lists of numbers separated by commas are called sequences. 
Mathematically speaking sequences are functions with domain the set of integers, but instead of using 
the standard f(n) or g(n) notation, the alternative xn or un are preferred, but with DERIVE the standard 
notation will be used. 

Closely connected with sequences are series. Series are obtained by adding together the terms of a 
sequence. The value of this combined addition is called the sum of the series. 

e.g. the finite sequence   1,2,3,4,5,6,7,8,9,10, 

gives the series    1 + 2 + 3 + 4 + 5 + 6 + 7 + 8 + 9 + 10, 

and the sum af the series is     55. 

 

Using Derive the sum can be obtained iteratively by using an array v in which the first element is 
the successive numbers of the series and the second element is the sum of the series. The iterative 
formulae being used are  x:=1  and  s:=1  initially and x is increased by 1 each time whilst s is in-
creased by x  i.e.  x ← x + 1, s ← s + x. 

The initial value of v is [1,1]. The first element of v represents the next number in the series, the 
second element represents the current value of the sum. Derive updates its copy of v using the function 
ELEMENT, which extracts elements of arrays. The next number in the series is found by using 

ELEMENT(v,1)+1                              

Works still but more comfortable use v sub 1 + 1 which appears as 
 

The value of the sum is found from 

1+element(v,1)+element(v,2) or better 1+v sub 1+v sub 2 = 1+v
1
+v

2
. 

The first two elements represent the new value of the nth term added to the third term representing the 
previous sum. 
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The command to automate this is: 

 

Naturally infinite sequences and series do occur. The idea of convergence can be used with series 
as well. If the sum to infinity is finite then a series is called convergent. The problems of investigating 
the convergence of series are many and varied and still the subject of active research. This module will 
give some ideas of the use and problems with sequences and series. 

First note well that a convergent sequence does not mean that the corresponding series will con-
verge. 

The infinite sequence       1, 1, 1, 1, 1, 1, 1, ......... 

is convergent, but the infinite series 1 + 1 + 1 + 1 + 1 + ....... 

is divergent. 

 

Do not be deceived by the size of the first few terms in a series, it is the long term behaviour of a 
series that matters. 

Use Derive to find the sum of the first few terms of the series 

2 3 4 5

100! 100! 100! 100! 100! 100!... ...
1 2 3 4 5 nn

+ + + + + + +  

 
The sum looks very large and impressive. However, this series has a finite sum, since the denominator 
eventually gets much larger than the numerator. Try 

   and simplify the expressions. 

The answer is a two column array in which the first contains the terms 
of the series and the second column the corresponding sum of the 
terms so far. 
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Whereas, the sum of the series in which each term is the reciprocal of the corresponding one in 
this series, starts small, but eventually grows without bound. Repeat the trial by looking at the first few 

sums of 
100!

nn
. Then examine the later terms, these are very large and increasing so that the sum would 

grow without bounds i.e. the series is divergent. 

However, you must not be mislead into thinking that individual terms must be large for the series 
to be divergent, it is the cumulative effect of adding an unlimited number of terms that is important. In 
fact the series 

1 1 1 1 1 11
2 3 4 5 6 7

+ + + + + + +…  

caused by adding the reciprocals of the integers is divergent, even though the individual terms get very 
small. It is impossible to show the divergence by just finding the sums to a finite number of terms, the 
divergence needs a theoretical proof. This series is a famous one in mathematics and is called the 
harmonic series. 

 

ARITHMETIC SERIES 
 

The series 
1 + 2 + 3 + 4 + 5 + ... 

is obtained by summing the terms of the sequence 

un+1 = un + 1    with  u1 = 1. 

In fact any sequence of the form 

un+1 = un + d 

with  u1 given an initial is called an arithmetic sequence and the sums of the terms of these sequence 
are called arithmetic series. 

One of the fascinations of mathematics is finding alternative ways to solve problems. Faced with the 
problem of adding 

1 + 2 + 3 + 4 + 5 + 6 + 7 + 8 + 9 + 10 

the obvious way is to do the addition and get 55 either with pencil and paper or using the iteration and 
calling 9 times. Summing from 1 to 100 is much more arduous and all programming languages have 
ways of instructing the computer to carry out repetive steps. An alternative way is to find a method of 
getting the answer from a formula and avoiding the repetetive steps. This is usually not possible, but in 
most instructive examples the alternative of finding a formula is possible. 

In the case of arithmetic series, this alternative of a formula for the sum is possible. The following 
trials are aimed at producing a formula for the sum of an arithmetic series. 

Considering the sequence   un+1 = un + 1    with  u1 = 1 

it is very easy to find the 10th term, it is 10, the 100th term is 100 etc. so in this case the nth term is n. 

The sum of the terms is less obvious. So try to author a few iterations consulting the previous ex-
ample if you need to see how. The answer gives two columns: in the first one are the values of n and 
in the second one are the values of the sum to n terms. So for the n sequence 

1, 2, 3, 4, 5, 6, 7 

the s (i.e. sum) sequence is:   1, 3, 6, 10, 15, 21, 28. 
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To try and work out a formula connecting the sum to n terms with the value of n, trial and error 

can be tried, but a systematic approach is best. Assuming s = a n + b  i.e. a linear relationship, fit this 
equation to the first two terms to find values of a and b see if the formula predicts the third and higher 
values. When n = 1, s = 1; n = 2, s = 3. DERIVE expects you to enter linear equations in the form of a 
vector, so the [,] brackets must be typed, around the equations. 

 
Hence author s = 2n – 1 

To test this conjecture that this is formula is true if n = 3 gives s = 6. Substitute for n and s: 

 

The linear guess is wrong. (Undoubtely you will not need a CAS for this calcula-
tion, but it might be useful for later to learn this procedure.) 

Trying again with a second degree equation s = a n2 + b n + c there are three unknown coefficients a, b 
and c, so the first three terms will be needed and then the predictions for the fourth and higher terms 
can be attempted. Author the first three equations as a vector and solve, remember to type the [ ] 
around the equations. 

 

and these answers make 
2

2 2
n ns = + . To test for higher terms it is possible to use a DERIVE command 

which allows you to do repeated substitution into a formula. It is called VECTOR and has four argu-
ments, the first for the expression, the second for the variable, the third for the starting value and the 
fourth for the finishing value. 

 
giving complete agreement. 

 

Exercises. 

1. Consider the iterative sequence 

 un+1 = un + 2    with  u1 = 1. 

 Generate the first seven terms of this sequence and also the sum for n = 1, 2, 3, 4, 5, 6, 7.  
Use your results to produce a formula for the nth term and a formula for the sum to n terms. 

2. Use the iterative formula un+1 = un + d. 

 Choose your own u1 and d and see if you can find the formulae for the nth term and the  
sum to n terms. 
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Working with the general arithmetic sequence un+1 = un + d, u1 = a, you can find its sequence of 
partial sums by working with iterates and a vector with three elements. This is so that the first element 
can keep count of the number of terms, the second element can update the current value of the nth 
term and the third element can add the nth term to the previous sum. 

 
 

 

The first column sequence represents the 
number of terms, the second column sequence 
gives the value of the nth term (u) and the third 
column the sum sequence gives the value of the 
sum to n terms (s). The problem is to find a for-
mula relating the value of n with the values of the 
nth term u and the sum s. 

 
 

Can you spot the relationship between n and u? 

 

In conventional work the first term is usually denoted by a and the commom difference by d, so 
that the formula for the nth term would be  a + (n – 1) d, which should be equivalent to the one you 
obtained. 

The connection between n and s is not as obvious, since both a and d have changing coefficients. 
Can you spot the formula connecting the nth term with the coefficient of a? Write down the sequence 
of coefficients of d. Have you seen this sequence before? If so can you construct the formula relating 
the coefficient of d with n? 

Finally can you combine your two results to show that your formula is eqivalent to 

[ ]2 ( 1)
2

= ⋅ + − ⋅n
ns a n d  

(to be continued) 

 

(David E. Hodgkinson, Department of Applied Mathematics and Theoretical Physics, University of Liverpool) 
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How to write my own DEMO-file? 

Josef Böhm, Würmla   
When I want to use DERIVE for demonstrating the procedure how to solve a problem I'm glad to have 
of a Demo-file at my disposal. Students or colleagues start with File>Load>Demo File>Filename. 
They are able to stop the "demonstration" at any position to do their own calculations, change the op-
tion settings, plot partial results etc. In addition they can find in the message line a short description, a 
little hint, an important explanation, ..... 

   I was curious and inspected an original DERIVE -.dmo-file. In DOS: type arith.dmo. It's pure 
ASCII-Code. I saw the message to be printed on screen in the first line, starting with a semicolon. The 
next line was a DERIVE -expression, written in its very own syntax. That was all! 
   Now let me write a Demo-file called SKETCH.DMO to demonstrate investigating a function graph. 
You can use each editor, which creates ASCII-files. I prefer WORD and save my file as ASCII-file 
with the extension .dmo. Another way to edit this file is in DOS: 

       copy con: sketch.dmo    etc.   
 
;This is the function to be investigated 
f(x):=(x^4-11x^3+29x^2+35x-150)/30 
;f(x) = 0 to obtain the zeros 
SOLVE(f(x)=0,x) 
;f'(x) is the 1st derivative which is defined as f1(x) 
f1(x):=DIF(f(x),x) 
;zeros of f'(x) give the relative extrema, ESC, Approx, Notation 
Decimal, Simplify 
SOLVE(f1(x)=0,x) 
;These are the turning points! Set back to Exact and Rational  
[5,f(5);-0.47038,f(-0.47038);3.72038,f(3.72038)] 
;Hurry up for the 2nd derivative 
f2(x):=f''(x) 
;f''(x) = 0 gives the inflection point(s), ApproX, Notation Decimal 
SOLUTIONS(f2(x)=0,x) 
;Here are the complete coordinates! Study the Derive command! 
VECTOR([u,f(u)],u,SOLUTIONS(f2(x)=0,x)) 
;We need the slope in the inflection points for a fine sketch 
[f1(1.098),f1(4.402)] 
;Let's proceed with the indefinite integral in Exact Precision 
INT(f(x),x) 
;Whatïs the area between graph and x-axis between the zeros 
ABS(INT(f(x),x,-2,3))+ABS(INT(f(x),x,3,5)) 
;ESC, Change to 2D-Plot Window, highlight f(x) and plot the graph 
f(x) 
;Finally we will shade the area 
(-2<=x<=3 AND f(x)<=y<=0) OR (3<=x<=5 AND 0<=y<=f(x)) 
 
This was from 1991. Nobody will work with copy con .... in 2004?? 
 
We have other choices: 
 
(1) If you like the nostalgic way you might work with the DOS-Editor. So switch to DOS and type 

edit sketch.dmo. 
(2) You can do it from the DERIVE 6 environment or 
(3) You can use your handheld CAS-Device and apply InterConnectivity. 
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Don´t use the textprcessor now because of differences between ASCII and ANSI-code! 

This is the first – nostalgic – way. You must be very careful typing the DERIVE commands in the cor-
rect syntax and typing them in uppercase. In DOS mode call edit sketch.dmo and start editing:  

 
Having finished and saved the file you should be able to load this file as a demo file in DERIVE. The 
first expression appears in the Algebra Window and in the message line on the bottom you will find 
your comment. 
 

  
You can write your complete DEMO-file with the Editor. But possibly you will prefer the DERIVE 
environment, because you want to convert a successful DERIVE-session into a Demo file and without 
typing in all the stuff once more in the editor. 

So do the following: 

Highlight the expression which should be executed, go for Edit>Annotation and write your com-
ment as shown below. Later this comment will appear in the message line. 

 

  
I recommed to delete all simplified or approximated results before saving the file. So I would delete 
expression #10. Otherwise they would appear twice. 

The message line (bottom left): 
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When you are ready with the session then you have to save the file in such a way that DERIVE will 
recognize it as a demo-file.  
 
You must take care of two details: 

• Save the file as a Math- (mth-) file 

• Type the name of the file under quotes with the filename extension .dmo. 

 
 

If you are the happy owner of a TI-92 PLUS, Voyage 200, TI-89 or TITANIUM then you have a third 
chance to produce a DEMO-file: 
 
At first create your demo as a script on the hand-
held device. 
 

 
 
It is not necessary to save the *.dmo-file under the 
name of the script!!  
All your one-line comments in the script which are before an expression will appear as comments in 
the DEMO-file. 
 
 
If you would import the same file as a worksheet 
then you would find your comments in text-
boxes. 
 
The picture shows the start of the file. 
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CALL FOR APPLICATIONS 
 

International Spring School on the Didactics of Computer Algebra 
April 27-30, 1992 
Krems, Austria 

 
Computer Algebra is a new technology with an immense impact on techniccal sciences. The 
personal computer algebra system DERIVE has found its way to all levels of education. It has 
pleased many teachers but also surprised others. The availability of DERIVE on very inex-
pensive hardware and the new palmtop size Pcs enables more and more students to use the 
system for their assignments or in school. 
 
How will math teaching need to be changed to cope with thie new development? this spring 
school aims to bring together people with an interest in developing a didactics of computer 
algebra for the math education of students aged 12-18. 
 
The program will consist of presentations of classroom experiments, discussions and working 
groups. The organizers provide full lodging and boarding. The number of participants is 
strictly limited. 
 
We invite your application to participate. Applications should include the following items: 
 

- full name and address, 
- list of activities related to 'computer agebra in education' (own experiments, 

publications, workshops, seminars, etc.), 
- an extended abstract on what you will present at the meeting, 

 
to be sent to the following address: 
 
              Research Institute for Symbolic Computation 
              Univ. of Linz, att. Dr. B. Kutzler 
              A-4040 Linz, Austria, fax +43-7236-3231-30 
 
to arrive no later than 
 
                  February 15, 1992. 
 
The Notification of acceptance will be mailed February 29,1992. 
 
This spring school is jointly organized by the following institutions: 
 

6 Landesschulrat für Niederösterreich, Wipplingerstr. 28,  
     A-1010 Wien, Austria (LSI Dr. Helmut Heugl) 

6 Bundesministerium für Unterricht und Kunst, Wipplingerstr. 20, 
     A-1010 Wien, Austria (MR Dr. Eduard Szirucsek) 

6 Research Institute for Symbolic Computation, University of Linz, 
     A-4040 Linz, Austria (Dr. Bernhard Kutzler) 
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